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RightNow Environmental Configuration Guide

Purpose

This guide is intended to assist in the initial installation and proactive maintenance of your of
your RightNow 8.x implementation. Adherence to the guidelines laid out in this document
will help to ensure optimal performance and stability of your RightNow deployment.

Product architecture, network requirements, workstations configuration requirements,
installation methodologies, network maintenance, and workstation troubleshooting are each
covered herein. Please see our knowledge base at http://rightnow.custhelp.com for updates
in each of these areas.

RightNow Architecture

The RightNow application is a rich Internet application utilizing a standard 3-Tier
architecture consisting of the following:

Smart Client Tier: The client tier consists of a .NET Smart Client application that presents
content received from the application tier. The client tier communicates with the application
tier through the Internet via Hypertext Transfer Protocol (HTTP) or Hypertext Transfer
Protocol with Secure Socket Layer (HTTPS).

Application Tier: The application tier provides the business logic for the RightNow product
and communicates data from the database tier to the client tier. This tier resides on a web
server.

Database Tier: At the base of the application is the database tier, consisting of the database
management system that manages the database containing the data users create, delete,
modify, and query.
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Networking Requirements and Recommendations

As the RightNow application is web services based, the corporate network plays an important
role in the efficient and consistent connectivity to the application. The following items should
be considered when implementing the RightNow solution:

Bandwidth: For satisfactory performance, a high-speed Internet connection is required. Dial-
up connections are not supported. The information below provides guidelines for the network
bandwidth to the Internet.

As a recommended minimum, 25kbps (kilobits per second) must be dedicated per concurrent
logged in agent. For example, if there are 20 agents logged in, a minimum of 500kbps of
dedicated WAN / Internet bandwidth should be available for the RightNow application.

As an example, based on the above recommendation, a T1 line will support approximately 60
concurrent agents, depending upon the particular implementation & the usage patterns of the
agents in question. Regular bandwidth utilization monitoring should be done in production
environments to facilitate the tuning of the amount of bandwidth provisioned and its optimal
utilization.

If your network utilizes a private WAN (typically over multiple call centers) specified
bandwidth must be available throughout the entire network path; that is from the Internet to
the Private WAN to the LAN and to the Agent workstation.

Response Test Time: Your network connectivity to the RightNow data center (either
Internet or private WAN) should provide less than a 300ms round trip time (RTT) and less
than 1% packet-loss. Where possible, your IT/IS staff should work to minimize WAN /
Internet latency to ensure proper application performance.

Network Appliances (including Proxy Devices, Firewalls, and Content Filters):

The customer network administration team must ensure that all communication between the
RightNow client application and the RightNow hosted server is allowed, in an unrestricted
manner, through all levels of the customer network. All network appliances must be
configured to allow all traffic between the client workstations and the following domains to
occur in an unrestricted manner:

*.custhelp.com
*.rightnowtech.com
*.rnttraining.com
activex.microsoft.com
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Applicable network appliances include the following (but are not limited to):

Gateways
Routers

Hubs

Bridges
Switches

Proxy Servers
Firewalls

Load Balancers

Proxy servers must be configured with authentication and caching exclusion rules for each of
the domains listed above.

Firewalls must be configured to allow traffic on HTTP port 80 and HTTPS port 443 for the
domains listed above.

Customers using HTTP / IP proxy devices, either directly or indirectly, must ensure that
these devices are configured to exclude RightNow application traffic. These devices include
but are not limited to:

Traditional proxy server (PC server or dedicated appliances)
Content caching/acceleration devices

Local content filtering/inspection appliances

Hosted content filtering and inspection services

Quality of Service (Qo0S) Packet-Shaping Policies: If your networks have QoS / packet-
shaping policies implemented, the RightNow application should be considered a
performance-sensitive application and accordingly given appropriate priority to ensure
maximum performance.

If your organization has not instituted QoS/packet-shaping policies, you should consider the
economic advantages of grooming network traffic to provide priority applications, such as
your RightNow application, sufficient access to network resources. Whenever possible,
customer LAN / WAN connectivity should be groomed to match generally-accepted VOIP
standards:

Less than 300ms round trip time (RTT),

Less than 5% latency jitter,

Near-zero packet-loss, and

Appropriate / consistent Layer-2/3 QoS policing.
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Wide Area Network / Internet Load Balancing

Wide area network (WAN) and internet load balancing must be performed in a per-session
vs. a per-packet manner for RightNow traffic. Per-packet load balancing often leads to out of
order packet delivery which will result degraded performance of your RightNow application
and may result in its decreased stability.
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Workstation Requirements and Recommendations

The RightNow solution consists of a .NET Smart Client application that is automatically
installed and updated from the RightNow site. In addition, the Management and
Configuration portions of the application require the Microsoft Internet Explorer Web
Browser. The following items are recommended to maximize application performance.
These are listed in addition to the workstation requirements published on the RightNow
support website.

Hardware Configuration: The minimum hardware recommendations for the staff member
workstation listed in Table 1 are for RightNow applications. These recommendations do not
include the additional disk space required for operating system swap space (refer to the
operating system documentation) or other applications simultaneously running on the
workstation.

Table 1: Minimum Workstation Hardware Recommendations

RightNow CRM Workstation Memory CPU Hard Disk
Version Type
8.X Agent Min: 512 MB Minimum: 700 50 MB free with 512 MB
Recommended: 1 | MHz virtual memory
GB Recommended:
-1GHz
-15GHz
Administrator Min: 512 MB 1.5 GHz 50 MB free with 512 MB
Recommended: 1 virtual memory
GB

*Required free hard drive space will vary depending on database size and file attachments.

Operating Systems: RightNow staff member and end-user functions are best performed on
workstations running the following operating systems. Operating systems that are not listed
for a corresponding release in table 2 are not supported.

Table 2: Supported Operating Systems

RightNow CRM Version Supported Operating Systems

8. Windows 2000 Professional (SP 4)
Windows XP Professional (SP 2)
Windows 2003 Server*

* If you are running Windows 2003 Server, Enhanced Security Mode cannot be
enabled in Internet Explorer.

Workstation Display Settings: To view RightNow windows, consoles, and panels, you
must configure the display properties of your workstation to display a minimum screen area
of 1024 by 768 pixels with the “small fonts” or “normal size” (96 dpi).
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NET Framework: RightNow staff and administrator workstations require and must support
.NET Framework Version 2.0. If the .NET Framework 2.0 is not installed on a given
workstation prior to the installation of the RightNow solution, the user will be prompted to
download and install the .NET Framework 2.0 before the installation can proceed. Note that
NET Framework 2.0 and 1.1 versions can co-exist on a given workstation, therefore
enabling the mass installation of the 2.0 version prior to the deployment of RightNow 8 with
no disruption to the RightNow 7.X implementation.

Web Browsers: The 8.x version of the RightNow solution requires a PC version of
Microsoft Internet Explorer. Such users must have Internet Explorer set as their default
browser. Table 3 shows Internet Explorer version requirements. For end-user web browser
recommendations, refer to Answer ID 31 at http://rightnow.custhelp.com.

Table 3: Internet Explorer Version Requirements

RightNow CRM Internet Explorer
Version Version

8.X 6.0 (SP1lor
newer) or 7.0

Additional Requirements: If you are using RightNow Live or RightNow Sales, refer to
Table 5 for software and hardware requirements. These requirements are in addition to the
workstation recommendations listed above.

Table 5: Additional Requirements

RightNow CRM User Additional Requirements
Version
8.X RightNow Live Agent Java browser plug-in Version 1.5.0 02
Sales Quotes Staff Member Microsoft Word 2000 or newer (merging
quotes only)
Disconnected Access Staff - Apache 2.0
Member - Minimum of 500 MB free hard disk space

- Minimum 1.5 GHz processor
- High-speed Internet connection for
synchronizing
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Workstation Settings (Required for Administrators Only): Not all of these settings will

appear for Windows 2000 workstations. Additionally, several settings are marked for
troubleshooting only.

1.

(Required) Verify current user is member of workstation Administrators Group: Start
> Control Panel > Administrative Tools > Computer Management > System Tools >
Local Users and Groups > Groups > Administrators

o Verify the current Windows profile is listed under the Administrators group.
Verify Browser Encoding Settings: Internet Explorer > View > Encoding

o Auto-select — Not selected
o Western European 1SO — Selected

Verify correct browser caching: Start > Control Panel > Internet Options > General
Tab > Settings Button

o Check for newer versions of stored pages — Every visit to the page
o Amount of disk space to use — Greater than 1000 MB

Verify Browser Security Settings: Start > Control Panel > Internet Options > Security
Tab > Internet (Globe Icon) Selected > Custom Level Button

o .Net Reliant Framework
= Run components not signed with Authenticode — Enable
= (Required) Run components signed with Authenticode — Enable

o ActiveX controls and plug-ins
= Run Automatic Prompting for ActiveX controls - Enable
= Binary and script behaviors — Enable
= (Required) Download signed ActiveX controls — Prompt or Enable
= (Required) Run ActiveX controls and plug-ins — Enable or Prompt
= (Required) Script ActiveX controls marked as safe for scripting — Enable or
Prompt

o Downloads
= File Download — Enable

o Miscellaneous
= Access data sources across domains — Prompt or Enable
= Allow scripting of Internet Explorer web browser control — Enable
= Allow Web pages to use restricted protocols for active content — Enable or
Prompt
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Allow script-initiated windows without size or position constraints — Enable
Display mixed content — Enable or Prompt

Launching of programs and files in an IFRAME — Enable or Prompt
Navigate sub-frames across different domains — Enable or Prompt

Userdata persistence — Enable

Web sites in less privileged web content zone can navigate into this zone —
Enable or Prompt

o Scripting

(Required) Active Scripting — Enable or Prompt
Allow paste operations via script — Enable
Scripting of Java Applets — Enable

5. Verify Advanced Browser Settings: Start > Control Panel > Internet Options >
Advanced Tab

o Browsing

Always send URLs as UTF-8 — Unchecked

Enable third party browser extensions — Enabled

Disable Script Debugging (IE) — Unchecked (when troubleshooting)
Display notification about every script error — Checked (when
troubleshooting)

Enable third-party browser extensions — Checked

o HTTP 1.1 Settings

Use HTTP 1.1 through proxy connections — Checked

o Java (Sun)

Use Java 2 v 1.4.1 x for applet — Checked

o Security

Allow active content to run in files on my computer — Checked

Do not save encrypted pages to disk — Unchecked

Empty Temporary Internet Files when browser is closed — Unchecked
Use SSL 3.0 — Checked (for sites using SSL)
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Installation Methodologies

Web-based Installation: To use the most common installation methodology, an agent
simply navigates to the appropriate URL, for example:

http://interface.custhelp.com/cgi-bin/interface.cfg/php/admin/launch.php

Select “Install RightNow 8’ on the launch page. Note, once the application is installed, it is
no longer necessary to navigate to the launch page. Instead, RightNow 8 can be started from
the Windows Start menu. The only time it is necessary to access the launch page is
following an upgrade.

The following is a rough sketch of the installation process:

Important Note: If the RightNow staff account has Management and Configuration
permissions, administrator privileges are required on the workstation in question at
the time of installation. This is necessary so that several ActiveX controls, which are
required by the Management and Configuration pages, may be registered.

1. The RightNow InitEngine is downloaded and installed using Microsoft’s ClickOnce
installation process. The InitEngine is downloaded and placed in c:\Documents and
Settings\{domain username}\Application Data\RightNow Technologies\InitEngine. If
the current version of the InitEngine already resides on the system, nothing is installed.
The InitEngine contains the login part of the application.

2. The RightNow Installer starts to execute and a login page is displayed, prompting for
username, password, and site URL.

3. When a user presses the ‘Login’ button on the login page, the username/password is
authenticated and, if valid, the RightNow Console application is downloaded and
installed in c:\\Documents and Settings\{domain username }\Application Data\RightNow
Technologies\SiteFiles\{interface name}. If the current version of the console
application for a site already exists on the user’s workstation, nothing is downloaded and
installed. The console application is downloaded in compressed .zip files and is
uncompressed and installed by the InitEngine.

Stand-Alone Installation: An installer is available for those organizations who have
concerns about the installation of software directly from the Internet or who would like to
automate its mass deployment. Please consult with your IT staff for your corporate
application installation procedures.

The process for stand-alone installation is as follows:

1 Open your web browser and type the following URL.
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Hosted:
http://<your_interface>.custhelp.com/rnt/rnw/installer/ClientFiles/
ExtInst/RightNow.PackagedlInstaller.exe
Click Save on the File Download window and select the directory where you want the
installer saved. This is a self-extracting executable file.
Double-click the downloaded .exe file.
At the prompt, enter the location where you want the files unzipped to. Two files will
be extracted: setup.exe and RightNow.CDInstaller.application, along with the
RightNow.CDlInstaller 8 0 0 ### folder.
To install RightNow on your workstation, double-click setup.exe. Once the download
is complete, the Login window will open. For information on logging in to
RightNow, refer to step 2 in “To download RightNow and log in:” on page 31 of your
Administration manual.
To make an installation CD to distribute RightNow to your staff members, burn the
resulting files and folder to a CD.
To make the client installation files accessible for staff members from a local network
directory, copy the ClientFiles.zip.deploy file from the
RightNow.CDlnstaller_8 0_0_### folder extracted in step 4 to a temporary location,
such as your desktop.

a Rename ClientFiles.zip.deploy to ClientFiles.zip.

b Extract ClientFiles.zip. The ClientFiles folder will be extracted.

c Copy the two folders and seven files contained in the ClientFiles folder to the
local network directory you want staff members to download them from.

d Set the configuration setting
Common>General>Components>COMP_DOWNLOAD_LOCATION to the
path to the local network directory where you copied the files in the previous
step.

Note: The client installation files in the local network directory must have read
permissions for all staff members who will be using RightNow.
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Network Troubleshooting

Your networks should be proactively monitored to avoid false-positive reports of application
issues. Even if your IT / IS staff are in another location, your staff should evaluate and check
the state of corporate LAN/WAN/Internet connectivity before submitting incidents to
RightNow's Technical Support team. This helps to ensure accuracy and efficiency when
troubleshooting your issue.

When requesting network troubleshooting assistance, please note the following guidelines:

WAN / Internet Performance Information You or your IT/IS staff should generally be
able to provide appropriate WAN / Internet troubleshooting and performance information.
This includes information such as:

 ICMP/UDP traceroute information from the affected call center to the associated
RNT datacenter,

« greater than 800-byte ICMP echo (ping) information from the affected call center to
the associated RNT datacenter, and/or other more specific IP and Layer-4 session
information related to reported issues.

Network Topology: You should be able to provide a description of your network topology,
such as single network, multi-site network with no connectivity, multi-site network with
public [VPN] connectivity, multi-site network with private/dedicated connectivity. This
description should include but not be limited to the following:

e ISP(s),

e circuit/access types (for both public and private network segments),

e routing equipment vendor to ascertain configuration capabilities,

o LAN/WAN utilization stats. Charts are preferred but the minimum, average, and
maximum values for each circuit and location are acceptable statistics.

o network appliances related to connectivity, such as firewalls, proxies, content filters,
plus their configurations.

Performance Monitoring Statistics: Basic LAN / WAN performance monitoring statistics
should be available to analyze per site and per workstation issues. In addition, raw logs that
provide information such as packet capture and network interface stats should also be
available. Open source and multi-platform packages such as MRTG are inexpensive and easy
to implement.
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Workstation Troubleshooting

When requesting workstation troubleshooting assistance, please note the following
guidelines:

Agent PC Configurations: You or your IT/IS staff should be prepared to discuss the state of
agent PCs, including system components and resource utilization with tools such as
Microsoft Perfmon. You should also be prepared to isolate individual agent workstations and
network interfaces for comparison purposes in the event sporadic application performance
conditions are present.
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Appendix A
Answer ID: 2412

What is the Workstation and Network Data Collector (rntinfo.bat
file)?

Question
Our support agent wants us to run the Workstation and Network Data Collector
(rntinfo.bat file) on some work stations to trouble shoot our support issue.

What does this file do and why is it necessary?

Answer

The Workstation and Network Data Collector is a .bat file that can be run on a work
station to collect pertinent system and performance information. This information is
written to a text file so that our RightNow support agents can review and evaluate the
following:

e Workstation information -- including memory and disk space

e Network connectivity -- traceroute information with loaded packets

e Component Manager Log file -- list of RNT components that have been
downloaded to the machine

If you have reported performance issues related to your RightNow application, your
Support Account Manager may request that you run the data collector .bat file and
attach the resulting .txt file to the incident.

To run the RNT_Info.bat file, use the steps below. Typically, when the file runs, it will
take 3-4 minutes for the file to run. Upon completion, the window will close
automatically and a new text file named rntinfo is saved to your desktop.

1. Click on the file attachment, found in the referenced answer, named rntinfo.bat.

2. At the prompt to Open or Save the file, click Save.

3. Save the file to your desktop. When you get the Download Complete message,
click Close.

4. From the desktop, double click the file or right click and select Open.

5. At the prompt, enter the site name and press Enter. This is the name of the
database for your application.

6. At the next prompt, enter the interface name and press Enter.

7. While the check is performed, text will scroll in the window and then periodically
pause. Leave the window running; it will close automatically upon completion.

8. When complete, a file named rntinfo.txt will be saved to your desktop.

9. Attach the rntinfo.txt file to your incident and update the incident.
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